LX 500
COLOR LABEL PRINTER

LX 500c
COLOR LABEL PRINTER

User's Manual

© 2016 All rights reserved
Table of Contents

Section 1: Getting Started.................................................................1
   A. Choosing a Good Location......................................................1
   B. Unpacking and Inspection.....................................................2
   C. Identifying the Parts............................................................3

Section 2: Hardware and Software Setup.................................5
   A. Installing Label Stock..........................................................5
   B. Adjusting the Stock Gap Sensor Position...............................7
   C. Using Fan-fold Label Stock..................................................10
   D. Installing the Ink Cartridge..................................................10
   E. Aligning the Ink Cartridge..................................................13

Section 3: Using the Status Monitor.............................................14
   A. Monitoring Ink Levels.........................................................15
   B. Set the Stock Sensor Mode..................................................16
   C. Output or Cut Mode (LX500c Only)........................................17
   D. Adjusting Label Offsets.......................................................20
   E. Using the Cost Estimator.....................................................22
   F. Settings...............................................................................23

Section 4: Printing Using a PC.......................................................24
   A. Using BarTender®...............................................................24
   B. Add Text, Barcodes and Graphics to BarTender Label..........28
   C. Printing from BarTender®....................................................29
   D. Printer Driver Settings (PC)..................................................30
   E. Printing from other Programs..............................................33

Section 5: Troubleshooting...........................................................35
   A. Solving Offset/Alignment Problems.....................................35
   B. Creating a Full Bleed Print..................................................38
   C. Clearing a Label Jam..........................................................39
   D. Cleaning the Printer...........................................................39
   E. Cleaning the Ink Cartridge..................................................40
   F. Technical Support..............................................................40

Section 6: Label and Roll Specifications.......................................41

Section 7: Technical Specifications.............................................44

Index.........................................................................................45
THANK YOU...

...for choosing an LX500 Color Label Printer. The LX500 Printer will print razor-sharp text and barcodes, vibrant colors, and even stunning photo-realistic photographs directly onto rolls of labels, card stock and fan-fold stock.

This User's Manual is your complete step-by-step guide to quickly and easily setting up and printing with your new Color Label Printer!

A. CHOOSING A GOOD LOCATION

- Place the printer on a flat surface in a location with adequate air circulation to prevent internal heat build up.
- Do not place the printer near heat sources such as radiators or air ducts, or in a place subject to direct sunlight, excessive dust, mechanical vibration or shock.
- Allow for adequate clearance in front of the printer to accommodate the printed label stock as it is leaving the printer to avoid the possibility of binding or jamming of the label stock.
- Allow for adequate overhead clearance for opening the top cover to allow easy access to the label stock and ink cartridge.
B. UNPACKING AND INSPECTION

While unpacking your printer, inspect the carton to ensure that no damage has occurred during shipping. Make sure that all supplied accessories are included with your unit. The following items should be included:

- Printer
- Power Adapter
- Separate Power Cord
- 6’ USB Cable (If other USB cable is used, it must be 6’ (2 M) or less.)
- Software Installer CD
- Color Ink Cartridge
- Starter roll of high gloss label stock
- Warranty Statement and Registration Card
- This manual and other printed information

Save the carton and packing materials. They will come in handy when transporting the printer.
C. IDENTIFYING THE PARTS

This illustration shows the front of the printer with its control buttons and LED indicator lights.

The **Ink Low LED** will illuminate when a cartridge has 10% or less of its ink remaining.

The **Power LED** indicates that the printer is on and ready to receive print jobs.

The **Ink Button** moves the carriage to the center to allow for loading of the ink cartridge. Once the cartridge is loaded, press the ink button again.

The **Load/Feed Button** is pressed in order to load label stock or form feed the label stock through the printer.

The **Unload Button** will unload the installed label stock by reversing it through the printer. Make sure to tear off the printed labels before pressing the Unload Button.

The **Label Tear Bar** is a serrated edge for conveniently tearing your finished labels from the printer.
This illustration shows the input ports and power switch found on the rear panel of the printer.
A. INSTALLING LABEL STOCK

Your printer will utilize a wide variety of paper label stock. As long as the label stock is paper and can receive ink jet printing and is within the allotted size, it will work in the printer. Primera carries a large variety of paper label stock that has been converted and ready for use with your printer.

1. Open the Top Cover.
2. Pull the spring loaded label stock guide out far enough to fit the label stock.
3. Remove any shipping tape from your label stock roll to ensure that it can unroll freely, making certain that no adhesive portion is exposed. It is important to note that any exposed adhesive surface can attach itself to the inner workings of the print mechanism and cause a media jam.

Note: If you are using fan-fold label stock or label stock other than standard square / rectangular die cut labels, see Sections 2B and 2C for additional instructions.
4. Place the label stock between the stock guide rollers and release the spring loaded stock guide to hold the label stock. The stock guide rollers allow the label stock roll to move freely.

5. Place the leading edge of the label stock between the throat guide and the side of the printer.

6. Quickly continue feeding the label stock further into the printer until you feel resistance from the feed rollers. The printer will sense the label and automatically feed it through the printer. If the printer fails to feed the label stock, press the Load/Feed button to manually engage the feed roller while continuing to guide the label stock into the printer.
**Tip!** To ensure that the label stock is fed straight be sure to push the label stock into the printer quickly until the entire front edge of the stock is touching the feed roller. For wider stock use both hands to feed the stock to maintain even forward pressure while you are pushing the stock into the printer.

### B. ADJUSTING THE LABEL STOCK GAP SENSOR POSITION

The stock gap sensor (TOF Sensor) "sees" the gap between label stock by shining light from the top of the label and attempting to read that light from a sensor on the bottom. By default, this sensor is set to read the gap .5" from the left side of the label stock. If the gap in your label stock intersects with gap position as shown on the slide bar you do not need to adjust this and you can skip this section. This does not need to be adjusted for most label stock.
If you are using label stock other than standard square / rectangular die cut labels such as circular die-cut labels or through-hole stock use the instructions below to adjust the label stock TOF sensor.

**Circular Labels**

If you are using Circular Labels you must adjust the Stock Gap sensor to correspond with the very top of the label where the circles are closest together. If the sensor is too far to the right or the left the printer will still sense the label but the image may be offset downward because the printer will start printing at the wrong position. If you are using stock that has multiple labels across make sure the sensor corresponds to a place on the stock that has a label and not a vertical gap.

The Sensor Bar has a guide in inches and millimeters that will help you identify where to set the bar to align the sensor over any identifying mark or top of a circular shape. To do this, measure the distance from the edge of the label stock to the correct position on the stock. Set the sensor bar to this measurement. For example, if you have a two inch circular die-cut label, measure from the edge of the label stock to the center of the circle. For this example it should be about 1 1/8 inches. Set the Sensor Bar to this value.
**Through Hole Labels**

If you are using card stock or label stock that has a hole punch or a notch to identify a transition from backing to label, you can adjust the Sensor Bar to position it over the identifying mark.

To adjust the sensor position use a pen to move the slide bar to the correct position.
C. USING FAN-FOLD LABEL STOCK

It is possible to use fan-fold label stock by feeding it through the fan-fold slot in the back of the printer.

Before feeding the fan-fold stock through the back of the printer, lock the stock guide in the out position so the stock guide rollers will not interfere with the label stock. The stock guide is spring loaded and under normal circumstances it will pinch any label stock roll inserted into the printer.

To lock the stock guide push the tab located on the bottom of the moveable stock guide to the out/locked position.

D. INSTALLING THE INK CARTRIDGE

When the cartridge reaches 10% remaining you will be prompted via the Status Monitor to replace the cartridge. If quality still looks acceptable you can choose to ignore this warning. However, you may waste labels if the cartridge runs out of ink before the next warning at 0%. If you choose to replace the cartridges follow the procedure below.

After installing a new cartridge, you may choose to run an alignment print to achieve maximum quality. However, this will require cancelling the print job. If you would like to enable smooth transitions between ink cartridge changes, you may choose to disable alignment print warnings. (See the next section).
1. Open the Top Cover of the printer.
2. Press the Ink Button on the printer.

3. The Cartridge Carrier will align itself to the center of the print area.
4. Press the Cartridge Cover Release to open the Cartridge Holder. Remove the cartridge (if installed).

5. Remove the new Cartridge from its packaging. Be sure to remove the protective tape covering the copper contacts.

6. Replace/install the cartridge copper end first.
7. Push cartridge cover downward until it snaps in place.

Note: Ink Cartridge Levels are estimates based on analysis of the printed images by the driver during spooling. This analysis estimates the number of ink droplets (spits) required to print the image and subtracts that amount from the total amount in the cartridge. It displays the total remaining spits as a percentage. In other words, there is no real time sensor that shows the actual amount of ink in the cartridge.

8. Press the Ink button on the printer to indicate the new cartridge is now installed. You will be prompted to align the cartridge. A warning will appear stating that you must have installed label stock that is equal to or larger than 4" x 2" (101.6 mm x 50.8 mm). If your label stock meets this requirement click OK to align the cartridge. If your stock does not meet this size requirement see the next section before clicking OK.
Cartridge alignment will align the Color Cartridge for bidirectional printing and calibrate the printer to each individual cartridge. You will automatically be prompted to perform this alignment each time you install a new cartridge. You may also manually align the cartridge via the status monitor.

For Alignment you will need to have installed label stock that is equal to or larger than 4" x 2" (101.6 mm x 50.8 mm). If your stock does not meet this requirement you can use the sample roll that came with the printer for this purpose. You may also choose to disable alignment via the settings area of the status monitor.

**Disable Alignment:** If you would like to enable smooth transitions between ink cartridge changes, you may choose to disable alignment print warnings. Alignment improves print quality if Bidirectional printing is enabled. It is not necessary if Bidirectional printing is disabled via the printer driver.

You can disable alignment via the status monitor.

1. Open the status monitor.
2. Select the settings tab (fifth tab).
3. Uncheck "Require cartridge alignment for best quality."

![Status Monitor Screenshot](image_url)
Section 3: Using the Status Monitor

The Status Monitor is used to interact with the printer for gathering ink levels, maintenance, alignment, cost calculation and several other functions.

It automatically installs with your printer driver and can be accessed through the printer driver preferences or as a program on your Windows start menu.

1. Connect the printer via USB and turn on the power. The Status Monitor accesses most of the information it uses from the printer itself so the printer must be turned on and communicating for the program to open.

2. Go to Start - Programs - Primera Technology - LX500 Status Monitor. The Status Monitor consists of five tabs that are arranged on the left side of the window. Each tab opens a screen that has various similar functions. The tabs will only be displayed if the printer is idle (not printing).

- Ink Tab (First Tab). Displays ink levels, and a print counter.
- Cartridge Settings Tab (Second Tab). Aligns Print Head, Cleans Print Head and Changes the Cartridges.
- Alignment Tab (Third Tab). Adjusts vertical and horizontal print alignment, Changes the Stock Sensor Mode and toggles the Output/Cut Mode.
• Cost Tab (Fourth Tab). Calculates cost per label based on last label printed.
• The Settings Tab (Fifth Tab). Adjusts language settings, automatic updates, Print alignment settings, see version numbers and generate log files.

A. MONITORING INK LEVELS

Ink levels can be monitored at any time by using the Status Monitor. Immediately after printing starts the Status Monitor will open and display the ink levels.

![Status Monitor Image]

The print status will also be displayed on the top bar. If a print job is currently printing you may click the cancel button on this screen to stop it.

Note: Ink Cartridge Levels are estimates based on analysis of the printed images by the driver during spooling. This analysis estimates the number of ink droplets (spits) required to print the image and subtracts that amount from the total amount in the cartridge. It displays the total remaining spits as a percentage. In other words, there is no real time sensor that shows the actual amount of ink in the cartridge.
B. SET THE STOCK SENSOR MODE

The stock sensor mode refers to the method the printer will use to detect the print starting position for each label. To adjust the stock sensor mode, open the Status Monitor. The LX500 Status Monitor automatically installs with your printer driver and can be accessed through the printer driver or as program that is accessible in the same manner as all other programs.

**Important Note:** _Set the Stock Sensor Mode BEFORE loading label stock!_

1. Connect the printer via USB and turn on the power. The Stock Sensor Mode setting is stored on the printer main board so you will not be able to access it unless the printer is turned on and properly communicating with the computer.

2. Go to Start - Programs - Primera Technology - The LX500 Status Monitor.

3. Click on the Alignment Tab (3rd tab from top).

4. Click on the Stock Sensor Mode button.

5. Select the Stock Sensor Mode by clicking on the graphic that most closely corresponds to the stock you intend to install.

![Color Label 500](image)
There are three sensor modes:

**Die Cut (Default).** If you are using standard die-cut labels that look similar to the graphic, use this setting regardless of the size of the label. Also, use this setting for Through-hole label material where a hole is punched through each label or a notch is cut in the side.

**Reflective.** Use Reflective for label material where a black pre-printed line (black mark) on the back of the label stock indicates the break between labels. Black marks are required on clear label stock rolls, or labels where the label waste matrix (waste) is left on the liner. Black marks can also be used for irregular shaped labels, circles larger than 4.6 inches or on any stock where the print starting position can not be sensed using the label itself.

**Continuous.** (Sensor off) If you have continuous stock with no die-cut, reflective mark or holes, set the sensor type to Continuous. This will turn off the stock sensor. In this mode there is no way to set the print starting position. The printer will simply start printing the first label and print each subsequent label immediately after that previous one. To produce a gap between prints simply add the desired amount of white space to the end of the label being printed.

*Important Note:* You must also set the Stock Gap Sensor Position (Section 2B) so that the sensor is sensing the correct point on the label stock.

### C. OUTPUT OR CUT MODE

Use the Output/Cut Mode to adjust how the printer presents labels after they are printed or if/when they are cut after printing. To adjust the Output/Cut Mode, open the Status Monitor.

1. Connect the printer via USB and turn on the power. The Output/Cut Mode Setting is stored on the printer main board so you will not be able to access it unless the printer is turned on and properly communicating with the computer.
2. Go to Start - Programs - Primera Technology - LX500 Status Monitor.
3. Click on the Alignment Tab (3rd tab from top).
4. Click on the Output/Cut Mode button.
There are different options available which change depending on whether you have the LX500 or the LX500c (Integrated cutter version). If the LX500 is connected the label present options will be available. If the LX500c is connected the present options are are no longer available but cut options become available.

Present Options:

**Do not present.** In this mode the label stock does not move after the last label is printed. This means that part of the last label printed is still in the printer. This should be used only if you have a label rewinder attached.

**Present after no activity.** This setting will present at the end of a print job if the printer does not receive another print job within one second of the last print job in the queue. You can use this feature to present at the end of multi-copy job, multi-page job or multiple individual jobs in queue.

**Present after button press.** This setting will present after you press the Load/Feed button on the printer. This can be used after one label or an entire job.

**Present after every label.** This setting will cause the printer to feed the last label printed forward so that it and the previously printed labels can be torn off using the tear bar. If no other jobs are sent to the printer within one second after the last label has printed, the last printed label will present for tear off.

**Present after specified number of labels.** This option will present after the number of labels specified in the "Present After___ Labels" setting. Change the value and then click "Set" to send it to the printer.
Cutter Options:

**Do not cut.** The label stays at the same position after printing.

**Cut after no activity.** This setting will cut at the end of a print job if the printer does not receive another print job within one second of the last print job in the queue. You can use this feature to cut at the end of a multi-copy job, multi-page job or multiple individual jobs in the queue.

**Cut after button press.** This setting will cut after you press the Load/Feed button on the printer. This can be used after one label or an entire job. This feature is useful if you will not be present at the end of the print to catch the cut label.

**Cut every label.** This setting will cut after every label.

**Cut after specified number of labels.** This option will cut after the number of labels specified in the "Cut After ___ Labels" setting above. Change the value and then click "Set" to send it to the printer.
D. ADJUSTING LABEL OFFSETS

The label offsets tab (third tab) will allow you to adjust the vertical and horizontal printing position of the label. If you see white on your label edges use this section to adjust the printing position.

If your previous experience with printing is limited to printing letters and cards to 8.5 inch by 11 inch paper you probably are not familiar with an essential part of a label printing - Print Offsets or Alignment. Standard printers feed a sheet and start printing based on the start of the sheet. They also prohibit printing to the edge of the sheet. This is to avoid any need for adjusting offsets. The LX500 senses the beginning of the label with an optical sensor and is capable of printing to top, bottom, left and right edge. Because of this it is necessary to align the printer to work with specific types of label stock.

The LX500 comes factory calibrated to print exactly to the edge of Primera label stock. However, due to variations in the left margins and other variables it may be necessary to fine tune these settings at the beginning of each roll. This is especially true for other non-Primera brand label stock.

Important Note: Before adjusting alignment settings first print one label at the quality level you intend for the entire job. This will ensure the label stock is moving at the same speed and the stock sensor will sense the gap in the same way.

Adjust print alignment using the Status Monitor. Go to the Alignment Tab (third tab).
Three items can be adjusted here:

- **Tear off Position.** This value adjusts the position of the last label printed after it has been presented for tear off. This only applies if the output mode is set to "Present the label." Add to the current value to move the tear point closer to the printer. Subtract from the current value to move the tear point away from the printer. After adjusting the value click the "Set" button to send the value to the printer.

- **Left Margin Offset.** This value moves the printed label left or right. Add to the current value to move the printed label to the right. Subtract from the current value to move the printed label to the left. After adjusting the value, click the “Set” button to send the value to the printer.

**Note:** Before adjusting this value make sure the label stock is properly loaded so that there is no gap between the edge of the liner and the fixed throat guide. Any gap at this point will greatly affect the Left margin offset value needed to align the label. Also, if you adjust the value with improperly loaded label stock you will have to adjust it again if you load the label stock correctly the next time.

- **Top of Form (TOF).** This value moves the print start position up or down on the label. Add to the current value to move the printed label down or toward the printer. Subtract from the current value to move the printed label up or away from the printer. After adjusting the value click the “Set” button to send the value to the printer.

You may have to make several adjustments to one or more of these values. After each adjustment you can click the Test button to print a small test pattern on the label. This will help you find the proper alignment value.
E. USING THE COST ESTIMATOR

The cost estimator is found on the fourth tab of the Status Monitor. The Status Monitor automatically opens as soon as you begin printing. However, you can also access it at any time as long as the printer is turned on and communicating by going to Start - Programs - Primera Technology - LX500 Status Monitor.

Ink cost is automatically and continuously calculated based on the black and color cartridge costs entered. Only the last printed label cost is displayed.

- Adjust the cartridge costs according to the actual price paid for them. The estimate does not take currency into account so you can assume that whatever value you entered is displayed in your currency.
- Save a screen capture of the cost by clicking the disk icon.
- Print a screen capture of the cost by clicking the printer icon.

**Important Note:** The cost per label represents the average cost per label over an entire run of labels. This means that the per label cost will decrease and become more accurate as the number of labels printed increases. This is because ink used for cartridge maintenance is divided into a larger number of labels.
The status monitor settings tab (fifth tab) allows you to adjust various advanced settings.

**Software Versions.** The Status monitor, driver version and printer Firmware version are displayed on the top of this tab.

**Cartridge Alignment.** Check the "Require cartridge alignment" option to maintain the highest possible print quality when printing in bidirectional mode. It is not necessary to align cartridges if Bidirectional printing is disabled via the printer driver preferences (See section 4D). If you would like to enable smooth transitions between ink cartridges changes, you may choose to uncheck this setting. If the setting is checked, you will be required to cancel the print job and run an alignment print every time you change a cartridge.

**Language.** Choose the display language of the LX500 Status Monitor by using the drop down menu on this tab.

**Log Files.** Click Save Log files to save a zip file with all relevant log files to your desktop. Tech Support may request this information during troubleshooting.

**Software Updates.** The status monitor is set by default to automatically check for updates once per day. This interval can be changed. If it finds an update it will prompt you to apply the update. The update may be for the driver, status monitor or printer firmware. You may also choose to check for Beta updates.
Section 4: Printing Using a PC

A. USING BARTENDER®

Primera Special Edition BarTender UltraLite is included with the printer. Other programs can be used to print. If printing from other programs please follow the guidelines in Section 3D.

When you open BarTender you will be given the choice to select an existing label or create a new one using a wizard. Use the following instructions as a general guide for standard labels.

1. Choose "Start a new BarTender document..."
2. Select "Blank Template". Click "Next".
3. Select "Color Label 500". Click "Next".
4. Select "Specify Custom Settings". Click "Next".
5. Set the page size, width and height to match labels installed in the printer. Click "Next".

6. Check the "Picture" box to add a background photo or graphic to your label. Click "Next". If you click "Finish", the remaining default wizard options will be set and no picture will be added.
7. Select "Embedded Picture". Click the "File" Button to browse to the location of your photo/graphic file. Set the Size Method to "Stretch". Note the preview to the right. Click "Next" if you are satisfied with the layout of the photo or graphic.

8. Review the label setup summary. If it is correct, click "Finish". Your blank label will be displayed.

After you click Finish, you can always go back and change any of these settings, by going to the File Menu and selecting "Page Setup". Basic and advanced settings are available on the various tabs.
B. ADD TEXT, BARCODES AND GRAPHICS TO A BARTENDER LABEL

Once you have created your label size you will need to add text, a barcode and/or graphics. This can be done using one of the buttons on the button bar at the top of the screen.

Add Text. Click the Text button. Now click anywhere on your label. "Sample Text" will appear. Edit the text on screen or double click it to open up text settings to change font, size and other settings.

Add Graphic. Click the Image button. Now click anywhere on your label. An Image icon will appear. Double-click it to open up image settings and browse to the image/graphic that you would like to insert.

Add Barcode. Click the Barcode button. Now click anywhere on your label. A barcode settings window will appear. Here you can choose any type of barcode and enter the value.

Print. Click the Print button to start printing.

Page Setup. Click the Page Setup button to change your label size, adjust corner radius or change the shape.

Lines. Click the Line button to add a horizontal or vertical line.

Tip! Double-click any object to open settings for that object.

Tip! Go to the Help menu to access the BarTender Manual and Tutorials.
C. PRINTING FROM BARTENDER

1. To print, click the Print button or go to the File Menu and select "Print". The Print Dialog window will appear.

2. Select the Color Label 500.

3. Set the number of copies.

4. Click "Document Properties" to adjust print quality settings. These settings are explained in the next section.

5. Click "Print".
D. PRINTER DRIVER SETTINGS (PC)

Settings changed via the method below will apply to all new designs created in BarTender or other programs after the preferences were changed. Existing labels saved in BarTender will not be affected since the preferences are saved with the label. To change these preferences you will have to change printer preferences through BarTender before printing by clicking the "Document Properties" button.

To find Driver Settings:
Click the **Start** button, choose **Printers and Faxes**. Right-click on the Color Label 500 Icon and select **Printing Preferences** from the drop-down menu.

The preferences screen will appear.
NOTE on PC Settings:
Most applications allow you to change these same printer driver options from their "Print" screens. Some applications such as BarTender save your settings with the label, others use settings only for the current print job just sent to the printer.

Paper Size
If you are using BarTender, this setting is adjusted during the label setup wizard. If you are using a program other than BarTender you will need to set this to the dimensions of your label. Keep in mind that the dimensions are always relative to the width and height of the actual label in the printer. Orientation of an image on the label should not change this setting. See Section 6 for minimum and maximum label sizes.

Orientation
There are two settings for orientation, Portrait and Landscape. If your text and graphics print left to right or as shown on the screen, select portrait. If you wish your printing to rotate 90 degrees from what you see on the screen so it is printing horizontally, select landscape as your orientation. Remember, this does not change the width and height in the Paper Size setting. It is only a tool for viewing a label upright on screen that will be printed sideways on the printer.
Print Quality

There are 4 levels of print quality in the driver. The lower the Quality, the faster the print. Quality 1 provides the fastest print available while Quality 4 provides the best quality. It is recommended that you experiment with the different levels when designing your label to find a good balance between print quality and print speed.

Color Matching

*Best for Graphics* mode is best used for graphical images where accurate color reproduction is not as essential. Images printed in this mode will look more vibrant because more ink is being used to produce them. However, printing images of people may produce skin tones that have a reddish tint.

*Best for Photos* mode is best used for photographic images where accurate color reproduction is very essential. Images printed in this mode will look lighter than those printed in Photo mode. Skin tones especially will look more natural in this mode.

*NOTE:* Exact color matching of the printed labels to the screen may never be possible since there are factors that affect this out of the drivers control. The surface of the label reacts with the ink in the cartridge to produce the color. For this reason, when printing the same image to different types of labels with different surfaces the printed output can look entirely different.

Ink Saturation

This option controls the amount of ink used when printing an image. The default setting is 100%, which will provide the most accurate color matching. If the ink is not drying fast enough or is bleeding, you can decrease the Ink Saturation to lessen the amount of ink that is applied to the label.

Enable Bidi (Bidirectional) Printing

Set to "Yes" for fastest print speed. Requires an alignment print after every cartridge change. Set to "No" for better quality print (in some cases).
Launch Status Monitor

Click here to open the LX500 Status Monitor. See section 3 for more details.

Details/Print Counter

Clicking on the Details button will allow you to view information about printer settings stored on the printer. There is also a print counter in the details window to help you count the number of labels printed since the last time it was reset. Click Reset Counter to set the counter to zero.

E. PRINTING FROM OTHER PROGRAMS

Since this printer uses a standard Windows printer driver you can print from any application you would like. There are just a few things to remember that will make it much easier.

1. Set the Page/Label Size in the Driver. BarTender automatically prompts you for the size of the label that you are using. When printing from any other program you must do this manually. Before you print, simply set the Paper Size just as you would set print quality in the printing preferences. In the example below the label size is 4" x 4" so the custom page size is set to 400 x 400 (displayed in .01 inch units).
2. **Check the image or document size.** The image size or document size should correspond to the Page/Label Size set in the driver. If you have set your page size in the driver to 4" x 4" but your image is actually 5" x 3" the printer driver will automatically shrink your image to fit inside the 4" x 4" label. The result is that the actual printed label is 4" x 2.4". Avoid this by setting your page size in the driver and image size in the printing application to match the label size installed in the printer.

3. **Choose the right printing program.** There are many different applications that are capable of printing to the LX500. However there are only a few that are ideal printing applications. For example, Adobe Illustrator is an excellent design program but is not always the best printing program. It can be difficult to find the printing preferences or to know the exact size of the art board. It is best to save as a PDF file and print from Adobe Reader or export as a 300 dpi JPG and print from BarTender.
A. SOLVING OFFSET/ALIGNMENT PROBLEMS

Image is Vertically Offset
(White space can be seen on the top or bottom of the label)

The LX500 decides where to start printing by detecting the start of a die-cut label, detecting a black mark on the back or detecting a thru-hole that corresponds to the start of the label.

The following items can cause the label sensor to improperly detect the start of a label:

1. **TOF Offset.** TOF stands for Top of Form and this setting allows you to fine tune the alignment of your printing on your label stock. This will be factory calibrated. If fine tuning is needed, increase this setting to move the image down on the label; decrease this setting to move the image up on the label. The unit of measure is 0.1mm. To access open the Status monitor and click on the Label Offsets Tab (third tab).
2. **Nonstandard / Non-translucent Backing Material.** Test the unit with the label sample material that came with the unit. If it prints correctly, your label stock may not be compatible. The label sensor needs to see the difference between a label and a backing material by seeing through the label stock for light variations. If it cannot see through the label, problems will arise. If you must use this type of backing, try label stock that has a black mark on the back to show where the label begins. You will need to change the Sensor Type setting in the driver preferences to Reflective if you switch to a label with a black mark on the back.

3. **Improper Label Gap Distance.** See Section 6 for label specifications.

4. **Page Size is Bigger than Label Stock Size.** If the page size set in the driver is larger than the actual label stock, ink will be printed on the gaps and the sensor will start looking for a gap too late. This can cause label skipping or inconsistent print starting points.

5. **Portrait / Landscape.** If the Portrait / Landscape setting does not correspond to the label stock installed this will also cause the printer to print over the gap and onto the next label. Make sure this is set correctly.

6. **Sensor Position.** Circular, nonstandard label shapes or multiple labels across will require precise adjustment of the label sensor. If you are using circular or other non rectangular die-cut labels see Section 2B for instructions.

**The image is printing horizontally offset**  
(White space is seen on the left or right side of the label)

Two printer driver settings can affect this issue.

**Left Margin Offset.** This adjustment is found in the Status Monitor. If you see white space on the right side of the label and overlap on the opposite side, increase the number. If you see white space on the left side of the label and overlap on the opposite side decrease the number (Negative numbers are allowed).
**Note:** Usually a space on the right side indicates a margin around the label that is not being accounted for. The printer is factory calibrated for a 2mm margin. A larger margin around the label will cause a right side space.

**Page Size.** Often the page size is not large enough for the label. If this is the case you may see white space on the right side of the label and no image overlap on the opposite side. This indicates that the page size needs to be increased. Increase the page size through the printer preferences enough to cover the label.
B. CREATING A FULL BLEED PRINT

1. If you are having trouble making the image cover the entire label, first make sure the image is printing at least as big as the label size you have selected. To accomplish this using BarTender, make the image a few millimeters larger than the label by dragging the image over the edge of the label on all sides. The bounding box around the image will turn red when it is over the edge of the label. Try printing again to see if it covers the entire label. If not, move on to step two.

2. Adjust these settings in the printer driver preferences:

   - **Page Size.** Increase the page size width in the driver preferences by .05 inches. Increase the height by .05 inches. If you are using BarTender, simply change the size under the File Menu - Label Setup. Increase the size of the image to fit the new larger page size. If you are using other graphics programs you will need to change the page size in the application and in the printer driver preferences.

   - **Left Margin Offset.** Decrease the Left margin offset by half the increase of the page size width. In this case you would decrease the value by 6 (which corresponds to .025 inches). This will center the page size increase so there is a .025 inch over bleed on both left and right sides.

   - **TOF.** Increase the Top of form by 6. This will cause the printer to start printing before the label and ensure a fully printed label.

![Diagram showing steps 1, 2, and 3 for creating a full bleed print](image)

**Note:** It is best to over bleed as little as possible to avoid excess ink on the label backing. Also, over bleeding too much will cause the printer to skip labels. This is because the printer stops printing too late to sense the next label.
C. CLEARING A LABEL JAM

If there is a label jam in the printer mechanism first attempt to remove the jam by opening the cover and removing the jam from the printer feed output area.

If the jam can not be located, it is possible to remove a cover over the feed input area. Pull on the center of the cover as shown below to release the tabs on the sides.

To prevent future jams, use rubbing alcohol to remove any adhesive left in the printer feed area.

D. CLEANING THE PRINTER

The case of the printer can be cleaned with an ammonia based window cleaner and a lint-free cloth.

Over time, ink overspray may gather at the base of the printer. The printer is designed using a vacuum system to gather most of this ink on a series of saturation pads. Eventually, these pads may need to be replaced. Contact tech support to determine if pad replacement is necessary.
E. CLEANING THE INK CARTRIDGE

It may be necessary to clean the ink cartridge nozzles if you notice reduced print quality, or if you suspect a cartridge nozzle has become slightly dried out or clogged. If you are having print quality problems, follow the steps below:

1. Remove the print cartridge.
2. Moisten a lint-free cloth with water.
3. Hold the cloth against the nozzles for three seconds. This will “wick” some additional ink onto the damp cloth.
4. Wipe in one direction only.
5. Repeat the process.

F. TECHNICAL SUPPORT

If you have difficulties operating your Printer, contact technical support using one of the methods listed below.

<table>
<thead>
<tr>
<th>Source</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primera Knowledge Base</td>
<td><a href="http://www.primera.com/kb">www.primera.com/kb</a></td>
</tr>
<tr>
<td>BarTender Software Help files</td>
<td>Open the software. Click on the Help Menu - BarTender Help</td>
</tr>
<tr>
<td>Email Support</td>
<td><a href="http://www.primera.com/contact_tech_support.cfm">www.primera.com/contact_tech_support.cfm</a></td>
</tr>
<tr>
<td>Phone Support</td>
<td>763-475-6669 (Mon - Fri 8 a.m. - 6 p.m CST)</td>
</tr>
<tr>
<td>Chat</td>
<td><a href="http://www.primera.com/contact_tech_support.php">http://www.primera.com/contact_tech_support.php</a> (Mon - Fri 8 a.m. - 6 p.m CST)</td>
</tr>
</tbody>
</table>
**Important!** Test all custom made label stock with the intended printer before ordering large quantities! Primera will only assume responsibility for custom label stock ordered from Primera.

**Label Sensing Methods**

- **Method 1: Label Gap Sensing**
- **Method 2: Width of thru-hole opening Sensing**
- **Method 3: Reflective/Black Mark Sensing**
  (Black Mark must be printed on back side of label stock)

---

**Label Width**

**Liner Width**

**Gap Between Labels**

**Distance from edge of Media**

**Width of Opening**

**Distance from edge of Media to edge of Label**

**Label Height**

**Black Mark Width**
<table>
<thead>
<tr>
<th>Specification</th>
<th>Max</th>
<th>Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label/Print width</td>
<td>4.25&quot; (108mm)</td>
<td>0.75&quot; (19mm)</td>
</tr>
<tr>
<td>Liner width</td>
<td>4.25&quot; (108mm)</td>
<td>1&quot; (25.4mm)</td>
</tr>
<tr>
<td>Label height/length</td>
<td>24&quot; (609.6mm)</td>
<td>0.75&quot; (19mm)</td>
</tr>
<tr>
<td>Gap between labels</td>
<td>0.75&quot; (19mm)</td>
<td>0.10&quot; (2.5mm)</td>
</tr>
<tr>
<td>Width of thru-hole opening</td>
<td>0.5&quot; (12.7mm)</td>
<td>0.375&quot; (9.5mm)</td>
</tr>
<tr>
<td>Distance from edge of media to edge of thru-hole</td>
<td>1.90&quot; (48.3mm)</td>
<td>0.20&quot; (5.1mm)</td>
</tr>
<tr>
<td>Reflective/Black Mark Width*</td>
<td>Equal to distance between labels</td>
<td>0.10&quot; (2.5mm)</td>
</tr>
<tr>
<td>Max Outer Diameter (OD)</td>
<td>5.0&quot;(127mm)</td>
<td>N/A</td>
</tr>
<tr>
<td>Inner Core Diameter (ID)</td>
<td>see roll specifications below</td>
<td></td>
</tr>
<tr>
<td>Stock Thickness**</td>
<td>.0010” (10 mil)</td>
<td>N/A</td>
</tr>
<tr>
<td>Distance from edge of media to edge of label</td>
<td>Printer driver assumes 2 mm gap. However, this is adjustable via the left margin offset.</td>
<td></td>
</tr>
</tbody>
</table>

* The Reflective/Black Mark should be opaque to infrared light. The mark should be between the labels. The end of the mark should correspond with the beginning of the next label.

**This is the recommended maximum. There are two factors that determine whether the printer will accept any particular stock thickness.

1. The ability for the printer to pull the paper through the print area.
2. The ability for the sensor to read through the backing if the sensor is set to die-cut.

If you are printing in continuous or reflective label sensing mode number 2 does not apply. The fact that the printer must read through the backing in die-cut mode will limit the thickness much more than the printer's ability to pull the paper through the print area. However, if you adjust opacity level of the liner enough to allow the label to be seen by the stock sensor, the thickness will only be limited by the printer's ability to pull it through the printer area. For these reasons the weight or thickness of the liner is a variable that can not easily be defined. Primera recommends and uses 40# liner with all label stock.

42 Label and Roll Specifications
Roll Specifications

Notes:
1. Label height ≤1.5" requires a 2.00" I.D. x 3.00" O.D. core.
   Label height >1.5" requires a 2.00" I.D. x 2.25" O.D. core.
2. Turret glue or 1/2"-wide 3M 928 double-sided removable tape must be
   used to attach stock to core. Removable tape must be positioned across
   full width of core. Other types of tape are not allowed.
3. End face of liner must align with end of core on both sides within 0.030".
   (Core width should be the same as liner width.)
4. Masking tape or equivalent may be used to secure label stock to outside of roll.
Section 7: Technical Specifications

Print Method: Inkjet
Print Resolutions: 4800 x 1200 dpi, 1200 x 1200 dpi, 600 x 600 dpi
Ink Cartridge: #53374 Color (CMY)
Colors: 16.7 million
Media Types: Roll-fed pressure-sensitive labels, roll-fed tags
Media Sensing: Moveable see-through sensor for die-cut labels and reflective for tags with black stripe sensing
Ink Level Warning: Calculates actual number of prints remaining based upon ink usage of graphics being printed (patent-pending)
Indicator Lights: Power, Ink
Controls: Ink, Load/Feed, Unload
Operating Systems: Windows 7/8/10, Macintosh OS X
Data Interface: USB 1.1
Minimum System: Pentium® IV computer or better, 512MB RAM, 5GB free hard drive space, USB 1.1/2.0 port
Software: Can also be used with most other popular Windows and Macintosh label design software programs
Electrical Rating: 12VDC, 5.0A
Power Requirements: 100-240VAC, 50/60 Hz, 60 watts
Certifications: UL, UL-C, CE, FCC Class B
Weight: 7 lbs.
Dimensions: 10.4" wide X 15.3" deep X 7.1" high (closed)
17.4" high (open)
Warranty: One year, parts and labor
Index

Cartridge Alignment ................................................................. 12, 23
Cleaning Ink Cartridge ............................................................. 40
High Gloss Label Stock ............................................................. 2
Ink Low LED ........................................................................ 3
Ink Saturation ........................................................................ 32
Installing the Ink Cartridge ....................................................... 10
Installing Label Stock ............................................................... 5
Label Size .............................................................................. 28, 33
Label Tear Bar ........................................................................ 3
Left Margin Offset .................................................................. 21, 36, 38
Load/Feed Button .................................................................. 3
Offsets ..................................................................................... 20
Orientation .............................................................................. 31
Power LED .............................................................................. 3
Print Counter ........................................................................... 33
Print Quality ............................................................................ 32
Printer Driver Settings ............................................................... 30
Printing .................................................................................... 24, 29
Sensor Type ............................................................................. 17, 36
Roll Specifications .................................................................... 43
Tear Off Position ...................................................................... 21
TOF Offset .............................................................................. 35
Troubleshooting ....................................................................... 35
Unload Button .......................................................................... 3
Using BarTender ....................................................................... 24